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СПИСОК СОКРАЩЕНИЙ И УСЛОВНЫХ ОБОЗНАЧЕНИЙ 

АО – атомная орбиталь 

МК – молекулярный кластер 

МО – молекулярная орбиталь 

ADF – Amsterdam Density Functional, название программного комплекса 

DFT – теория функционала плотности (density functional theory) 

GGA – обобщенно-градиентное приближение (generalized gradient 

approximation) 

HOMO – высшая занятая молекулярная орбиталь (highest occupied MO) 

LDA – приближение линейной плотности (linear density approximation) 

LUMO – низшая вакантная молекулярная орбиталь (lowest unoccupied MO) 

Ψ – волновая функция многоэлектронной системы 

φ – волновая функция отдельной МО 

re – равновесная длина связи 

Eсв – энергия связи 
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ВВЕДЕНИЕ 

Молекулярные кластеры (МК) представляют собой субнано-

размерные объекты, состоящие из нескольких атомов (рис. 1). Они 

являются промежуточным состоянием материи между атомами и 

наночастицами, поэтому их свойства, в том числе оптические, отличаются 

от свойств атомов (ионов) и наночастиц. В частности, для них характерны 

магические числа: зависимость свойств кластера и его стабильности от 

числа атомов в кластере. По химическому составу МК не отличаются от 

соответствующих полупроводниковых и металлических наночастиц. 

Однако они еще не обладают кристаллической структурой и 

полупроводниковыми либо металлическими свойствами. О существовании 

МК было известно на протяжении десятилетий. Однако интенсивное их 

исследование началось лишь в последние годы, когда выяснилось, что 

многие из них обладают яркой люминесценцией в видимой области 

спектра (рис. 2). Это делает молекулярные кластеры перспективными с 

точки зрения практического применения в устройствах фотоники: 

люминесцентных сенсорах, солнечных батареях, светодиодах белого 

свечения, для записи оптической информации и др. МК полупроводников 

и металлов могут быть синтезированы в жидких средах, полимерах и 

стеклах. В жидких средах люминесценция молекулярных кластеров 

чрезвычайно чувствительна к примесям. Поэтому жидкости с МК 

используют в качестве сенсоров вредных примесей, например, ртути, 

угарного газа, а также для исследования биологических объектов. Для 

устройств фотоники представляют интерес стекла с люминесцентными 

молекулярными кластерами. 

 

 
  а 

  
б 

Рис. 1. Расчетные структуры стабильных МК (CdSe)n (а) и Agn–Cl (б) 
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а                                                       б 

Рис. 2. Cтекло с МК серебра (а) и его люминесценция (б) после УФ облучения 
через маску 

 

Размер МК не позволяет использовать для их изучения структурно-

фазовые методы и электронную микроскопию, применяемые для 

наночастиц. С другой стороны, методы атомного и ядерного анализа также 

не подходят. Обнаружение МК в стеклах возможно с помощью оптической 

или лазерной спектроскопии. Однако выделить полосы МК заданного 

размера удается только при гелиевых температурах, что представляет 

значительное неудобство. Моделирование МК позволяет привести в 

соответствие данные спектроскопии и параметры МК, такие как размер, 

состав, геометрия, наличие оболочек. И наоборот, измерив оптические 

спектры стекла с металлическими МК, можно при помощи моделирования 

определить размеры и структурные свойства МК в стекле. Колоссальным 

преимуществом программного метода исследования является возможность 

исследования «чистых» частиц, без влияния окружения. Таким образом, 

моделирование МК формирует фундаментальную базу для последующих 

экспериментальных и теоретических исследований МК в стеклах. 

 Квантово-химический программный пакет ADF (Amsterdam Density 

Functional) [1] предназначен для расчета структуры и свойств атомов и 

молекул, как в газофазном, так и в конденсированном состоянии. Он 

может быть использован для решения широкого круга задач в таких 

областях, как молекулярная спектроскопия, органическая и неорга-

ническая химия, кристаллография и фармакохимия. Свою историю ADF 

берет с начала 1970-х годов, в то время разрабатываемая преимущественно 

двумя академическими группами из Свободного Университета Амстер-

дама и Университета Калгари (Канада). Продолжая свое развитие, сегодня 

ADF является одним из самых мощных программных пакетов, 

позволяющих решать широкий круг задач химии, физики конден-

сированного состояния и квантовой механики. Данное пособие ориен-

тировано на актуальную на момент написания версию ADF2014.06. 

 Пособие призвано ознакомить студентов с практическими аспектами 
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работы в программном комплексе ADF. Авторы избегают подробного 

теоретического изложения, поэтому многие объяснения могут показаться 

упрощенными. В связи с этим, читателю для более подробного изучения 

рекомендуется пользоваться литературой, приведенной в Списке лите-

ратуры. 

 Пособие состоит из четырех глав. Первая глава посвящена описанию 

молекулярных кластеров, их свойствам и методам получения. Во второй 

главе рассматриваются необходимые теоретико-познавательные сведения 

из квантовой химии. Третья глава знакомит с программным комплексом 

ADF и его графическим интерфейсом. Методические указания к 

выполнению лабораторных работ приведены в четвертой главе. 
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ГЛАВА 1. МОЛЕКУЛЯРНЫЕ КЛАСТЕРЫ МЕТАЛЛОВ 

ПОДРУППЫ МЕДИ: СТРУКТУРА, ПОЛУЧЕНИЕ, СВОЙСТВА 

 

МК представляют группу атомов или молекул, химически связанных 

между собой. Кластеры – это промежуточное состояние между нано-

частицами, обладающими металлическими свойствами, и молекулами 

металла. В отличие от молекул, кластеры не могут существовать при 

наличии контакта с себе подобными. Столкновение МК ведет к увели-

чению или к уменьшению их размеров. Обычно для стабилизации МК 

используют поверхностные лиганды.  

Важнейшей энергетической характеристикой, которая показывает 

стабильность МК, является энергия связи. Данную величину можно 

интерпретировать как энергию, равную работе, которую необходимо 

затратить, чтобы разделить систему на составляющие ее частицы и 

удалить их на такое расстояние, когда их взаимодействием можно 

пренебречь. Она определяется как разность полной энергии МК и суммы 

энергий образующих его атомов: 

   
      –∑   

   
 . 

Энергия связи МК – отрицательная величина.  

Устойчивость безлигандных МК зависит, главным образом, от 

заполненности их электронных оболочек.  Так, если электронная оболочка 

МК полностью заполнена, то МК имеет наибольшую энергию связи и 

является наиболее стабильным. Количество атомов n в МК с полностью 

заполненными (закрытыми) электронными оболочками (n = 8, 18, 20, 34, 

40, 58, 68, 90 и т.д.) носит название электронного магического числа. 

Существуют также геометрические магические числа, соответствующие 

структурам с наибольшей сферичностью и наименьшим отнощением 

площади поверхности к количеству атомов в МК. Принято считать, что 

электронные магические числа работают для малых МК, тогда как для 

больших возрастает роль геометрического фактора. На рис. 5 приведена 

кривая потенциальной энергии МК, оптимизируемых по геометрии. Таким 

образом, МК Cun с n = 13, 55, 147, 309 имеют наименьшую (наибольшую 

по модулю) потенциальную энергию. Иными словами, магические МК 

находятся в более глубокой потенциальной яме. 

С увеличением количества атомов в МК количество возможных 

вариантов их структуры возрастает (рис. 3, а). Задача геометрической 

оптимизации состоит в определении такой структуры МК, при которой 

кластер имел бы наибольшую (по модулю) энергию связи Eсв. Наиболее 

стабильные геометрии золотых МК приведены на рис 3. 
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Рис.3 а – график функции количества возможных структурных изомеров от 

числа атомов в МК серебра [1]; б – Оптимизированные структуры МК золота, 
обладающие наибольшей по модулю энергией связи, и их симметрия [2].  

 

Особенностью оптических спектров МК является их дискретная 

структура, в отличие от непрерывного спектра поглощения металлов и 

линейчатого спектра атомов (рис. 4). Такая особенность вызвана 

дискретным, но плотным расположением энергетических уровней, 

возникающих при взаимодействии электронных облаков атомов в 

кластере. Так же, как и для полупроводников, для МК свойственна 

запрещенная зона энергии. Эта зона, называемая энергетическим зазором 

HOMO-LUMO, т.е. между наивысшей занятой (HOMO) и низшей 

вакантной молекулярной орбиталью (LUMO), в значительной степени 

определяет оптические свойства МК. Степень проявления металлических 

свойств МК определяется концентрацией свободных электронов и также 

может быть охарактеризована величиной энергетического зазора HOMO-

LUMO (ΔEi), который равен нулю у объемного металла. На рис. 4 видно, 

что по мере уменьшения размеров металлических частиц величина зазора 

ΔEi увеличивается. МК металлов размером порядка 10 атомов уже не 

обладают металлическими свойствами. Известно также, что МК серебра и 

меди размером 2-10 атомов, как правило, обладают люминесценцией (рис. 

5).     
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Рис. 4. Влияние уменьшения размера частиц на электронную структуру 

металла 

 

 
Рис. 5. Схематическое изображение изменения люминесцентных свойств 

и потенциальной энергии с увеличением размера МК меди [3] 

 

Физические и химические свойства МК также непосредственно 

связаны с их строением и размером (рис. 6). Причем линейное изменение 

свойств характерно только для больших кластеров. На свойства малых 

кластеров оказывают большое влияние квантовый размерный и 

поверхностный эффекты, вызывая существенные отклонения от линейного 

закона.  

Свободные МК, рассматриваемые в нашем пособии, ближе всего по 

свойствам к МК, получаемым в вакууме и в инертных газах, поскольку там 

наименее сказывается влияние окружения матрицы. МК формируются при 

термическом (в печи) или лазерном испарении металлов в вакууме или 

инертном газе. Транспортировка МК для дальнейших измерений 

происходит в струе инертного газа. Управление размерами образуемых 

МК производится изменением температуры и давления в струе. Струя газа 
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с МК проходит через масс-спектрометр, позволяющий выделять МК по 

массе (по размеру). Для дальнейшего исследования свойств МК 

переносятся потоком инертного газа на твердую подложку или же 

окружаются твердой матрицей инертного газа. 

 
Рис. 6. Зависимость температуры плавления МК никеля, серебра и золота (а) 

[1] и зазора HOMO-LUMO МК меди (б) от количества атомов в кластере [4] 

 

Стекло, как прозрачная твердотельная матрица хорошо подходит для 

исследования оптических свойств МК. Однако сложность анализа 

экспериментальных данных в любой твердой матрице заключается в 

большой дисперсии размеров МК и необходимости учитывать окружение.  

 

 
  1           2    3        4   5 

              
Рис. 7. Схема формирования МК и наночастиц серебра в силикатном стекле 

при ионном обмене (Т > 410°С) [5] 

 

Удобным методом для получения МК в стекле служит ионный обмен 
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– обратимая реакция обмена ионами между твердым веществом и 

расплавом или раствором. Механизм ионного обмена в стекле основан на 

свойственной стеклу ионной проводимости. Щелочные ионы в стекле 

заменяются ионами благородных металлов из расплава. Но ионы, обладая 

электрическим зарядом, не способны объединяться в МК. Однако 

большинство промышленных стекол содержат восстановители, такие как 

As, Sb, Sn, Ce, добавляемые для осветления, повышения однородности или 

придания других специфических свойств. Поэтому при определенных 

условиях (нагрев, фотовозбуждение и др.) часть металлических ионов М
n+ 

в стекле восстанавливается до нейтральной формы Cu
0
 и Ag

0
. Процесс 

восстановления может происходить в процессе ионного обмена или 

термообработки. Поскольку благородные металлы плохо растворяются в 

стеклообразной матрице, они коалесцируют (срастаются), образуя МК 

(рис. 7, стадии 2 и 3). Термообработка стекла при температуре, 

превышающей температуру размягчения стекла, может привести к 

дальнейшему росту МК и образованию наночастиц (рис. 7, стадии 4 и 5). 

 

 

ГЛАВА 2.  НЕОБХОДИМЫЕ СВЕДЕНИЯ ИЗ КВАНТОВОЙ ХИМИИ 

2.1  Основные понятия 

Уравнение Шредингера 

Квантовая механика предоставляет нам возможность описать любое 

состояние электронной системы с помощью волновой функции Ψ. В 

символической форме стационарное уравнение Шредингера может быть 

записано как: 

 (кинетическая энергия + потенциальная энергия) ⋅ Ψ = E ⋅ Ψ, 

где E – параметр, характеризующий электронную энергию стационарного 

состояния, которое описывается волновой функцией Ψ. Как и в обычной 

жизни, в науке для наглядности легче разобраться с простым примером. 

Для случая одной частицы массой m, находящейся в потенциальном поле 

V(r) и движущейся в одном измерении, уравнение может быть записано 

явно в следующем виде: 

 
  

  

   

   
    (   )    , 

где ħ = h/2π — редуцированная постоянная Планка, а V – потенциальная 

энергия, зависящая от координаты частицы x и времени t.  

Для стационарных состояний многочастичной системы, состоящей 

из N электронов и M ядер, мы можем записать уравнение в более 

знакомом, компактном виде: 
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  (                   )    (                   ), 

где H — оператор Гамильтона, а волновая функция Ψ зависит от 

пространственных координат электронов и ядер системы (как правило, 

спин мы не будем явно указывать). 

Оператор Гамильтона может быть представлен в форме суммы пяти 

слагаемых: 

                   . 

Здесь Te и Tn — кинетическая энергия электронов и ядер соответственно. 

Эти два кинетических члена дополняются потенциальными членами, 

ответственными за кулоновскую энергию взаимного отталкивания между 

двумя электронами (Vee) и двумя ядрами (Vnn), а также энергию кулонов-

ского взаимодействия электронов с ядром Ven. 

 В случае адиабатического приближения Борна-Опенгеймера, по 

отношению к электронам более тяжелые ядра считаются неподвижными. 

Это позволяет разделить волновую функцию на электронную и ядерную 

компоненты: 

 (   )    (   )  ( ). 

В таком случае, после удаления ядерной компоненты, H приобретает 

форму электронного гамильтониана: Hel = Te + Vee + Ven. Теперь основная 

задача заключается в решении уравнении Шредингера для электронов: 

    (   )      (   ), 

и впоследствии, дополнение электронной энергии энергией ядер H = Hel + 

Tn + Vnn, может быть удовлетворительным приближением к полной 

энергии системы. Однако, как будет показано в подразделе 2.2, найти 

решения уравнения Шредингера для реальной N-электронной системы 

весьма затруднительно.  

Метод молекулярных орбиталей 

При рассмотрении многоатомной молекулы, в отличие от атома, 

возникает проблема определения волновой функции молекулы. Метод 

молекулярных орбиталей (МО), большой вклад, в разработку которого 

ввел Р. Малликен, предлагает решение этой проблемы. В данном методе 

предполагается, что электрон принадлежит всей молекуле в целом, а не 

отдельным атомам. При этом МО аналогична атомной орбитали (АО), с 

той лишь разницей, что в отличие от атомной является многоцентровой, 

т.е. зависит от координат всех ядер в молекуле: 

   ∑    
  

 
 .  

Здесь φi - молекулярные орбитали, которые выражаются как 

линейная комбинация всех АО χi (приближение МО ЛКАО), число 
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которых равно M. Одинаковые АО могут иметь разный вклад в 

результирующую МО, а величина вклада отдельной АО определяется 

коэффициентами разложения cij В общем случае набор функций {χj} 

называется базисным набором.  

Классификация МО осуществляется различными способами, но 

главным образом по энергии и симметрии МО.  

Так, для части МО положение электрона между ядрами будет более 

выгодным – энергия такой орбитали будет ниже энергии исходной АО и 

она называется связывающей. На связывающих МО электрон находится 

большую часть времени между ядрами, что повышает электронную 

плотность и способствует их химическому связыванию. МО, положение 

которой на шкале энергии выше исходной АО, называется разрыхляющей. 

На разрыхляющих МО, напротив, электрон пребывает большую часть 

времени в области за ядрами, что вызывает превышение сил отталкивания 

над силами притяжения. Существует и третий тип – несвязывающий, к 

которому относятся МО с энергией, равной энергии исходных АО. 

Электроны на этих орбиталях не участвуют в образовании связи. На рис. 8 

показаны МО, образующиеся из простейших АО. Каждая пара АО может 

образовать как связывающую, так и разрыхляющую орбитали. Несвя-

зывающие МО образуются, например, из p- и s-АО.  

 
Рис. 8. Иллюстрация вариантов объединения АО в МО в приближении 

ЛКАО: АО 1s (а) и 2px (б) образуют МО на основе σ-связи, двойное перекрытие 

АО 2pz приводит к образованию МО π-типа (в) 

 

Поскольку при объединении равнозначных АО возможно обра-

зование двух типов МО с отличной энергией, это приводит к расщеплению 

структуры энергетических уровней системы (рис. 9).  
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Рис. 9. Схема МО двухатомной молекулы водорода 

 

Согласно принципу наименьшей энергии, в основном состоянии 

атома электроны занимают АО, которые характеризуются наименьшей 

возможной энергией. Это соблюдается и для молекулы, когда электроны 

занимают МО, отвечающие минимальной энергии. Поэтому при 

образовании молекулы водорода (рис. 9) оба электрона перейдут с 1s-АО 

на связывающую σ1s-МО.  

 

2.2  Теория функционала плотности 

Системы многих тел как микроскопические системы, состоящие из 

большого количества взаимодействующих частиц, чрезвычайно сложны и 

в целом не могут быть точно решены, так как искать решение волновой 

функции N-электронной системы, зависящей от 3N пространственных 

переменных (и это не учитывая направление спина) – задача нераз-

решимая. Продемонстрируем сказанное наглядным примером. Если даже 

нам удастся найти достаточно точное приближение к Ψ и мы захотим 

записать ее в цифровом виде для последующего обращения к ней, то 

количество бит, необходимых для записи с учетом q битов на одну 

переменную равняется: 

     . 

При q = 3 (очень грубая аппроксимация) и N = 10
2
 получаем 10

150
 – 

совершенно недостижимое число. Для наглядности, количество барионов в 

доступной для наблюдения части Вселенной оценивается как 10
80±

. Стоит 

отметить, что сложность решения уравнения растет экспоненциально с 

размером системы: данная проблема относится к «экспоненциальной 

стенке» при решении многочастичного уравнения Шредингера.  
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 Радикальным шагом, сделанным в 1964 году, стали сформу-

лированные  теоремы Хоэнбергом и Коном,  а позже выведенные урав-

нения Кона-Шэма (1967), которые лежат в основе современной теории 

функционала плотности (DFT). На сегодняшний день DFT является одним 

из широко используемых и универсальных квантово-механических 

подходов к описанию электронной структуры квантовых систем многих 

тел. Основная концепция DFT заключается в том, чтобы использовать для 

описания системы из N электронов не многоэлектронную волновую 

функцию, а электронную плотность ρ(r) (рис. 10), которая выражает 

плотность вероятности обнаружения любого электрона системы в 

некоторой точке пространства r: 

 ( )    ∫   (           )          
   . 

Прежде перед перейти к описанию данной теории, определим что 

такое функционал. В то время как как функция y = f(x) является 

сопоставлением (f) между числом x и числом y, функционал F[n] может 

быть определен как правило сопоставления функции некоторому числу. 

Такими функциями могут быть волновая функция или электронная 

плотность. Обычно для обозначения функции, зависящей от аргумента, 

используются круглые скобки f(x), а для функционала, который зависит от 

функции — квадратные скобки F[f].  Простым примером функционала 

может быть количество частиц N: 

N = ∫    ( )        , 
которое является правилом для получения числа N по заданной функции 

плотности частиц ρ(r). Заметим, что аргумент функции ρ может быть 

опущен, так как функционал зависит от самой функции, а не ее 

переменной. 

Следующие утверждения являются основой DFT. Первая теорема 

Хоэнберга-Кона гласит, что для системы электронов во внешнем поле с 

потенциалом V(r) знание электронной плотности ρ(r) в основном 

состоянии однозначно определяет потенциал V(r) (с точностью до физи-

чески несущественной константы). Полная энергия основного состояния 

электронной системы может быть представлена как функционал плот-

ности: 

     ⟨     ⟩  ⟨         ⟩  ∫    ( ) ( )        

где V(r) – энергия взаимодействия с внешним полем, а F = ⟨       ⟩ – 

универсальный функционал, не зависящий от внешнего потенциала V. 

 Вторая теорема Хоэнберга-Кона утверждает, что для данного V(r) 
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плотность основного состояния минимизирует функционал полной 

энергии. Отсюда следует, что если с достаточной точностью известен F, то 

энергия основного состояния и плотность любой системы, независимо от 

количества частиц, может быть найдена путем минимизации E[ρ]: 

           . 

К сожалению, не так просто минимизировать неизвестный 

функционал, несмотря на то, что мы знаем на данном этапе о его сущест-

вовании: теоремы Хоэнберга-Кона являются лишь теоретической основой 

и не дают практических методов достижения энергии. Наряду с реальной 

системой взаимодействующих электронов с плотностью ρ, Кон и Шэм 

ввели в рассмотрение вспомогательную невзаимодействующую систему с 

той же плотностью ρ, что и у реальной системы (см. рис. 10 б):   

 ( )  ∑    ( ) 
      

   , 

где φi – одноэлектронные волновые функции или орбитали Кона-Шэма. 

Такие орбиталей, минимизирующие энергию, определяются посредством 

разбиения многоэлектронной задачи и решением одноэлектронных 

уравнений Кона-Шэма: 

( 
    

   
     ( ))       . 

Подобное одноэлектронное приближение подразумевает существование 

индивидуальных состояний каждого электрона в некотором эффективном 

поле, потенциальная энергия которого характеризуется vэфф, создаваемом 

ядром и всеми остальными электронам. 

В рамках формализма Кона-Шэма выражение для полной 

электронной энергии основного состояния формулируется как: 

                                       

где Ts описывает кинетическую энергию невзаимодействующей системы; 

Vne относится к энергии электрон-ядерного взаимодействия; J – 

кулоновская энергия отталкивания электронов между собой. Последний же 

член суммы, EXC – есть обменно-корреляционный (exchange-correlation, 

XC) функционал, который поглощает весь остаток, вызванный ошибками 

из рассмотрения кинетической энергии невзаимодействующей системы и 

энергии электрон-электронного взаимодействия. Его точный аналити-

ческий вид неизвестен и разработка точных приближений остается 

основополагающей задачей современной DFT. 
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Рис. 10. а) Решение уравнения Шредингера для реальной молекулы из N 
взаимодействующих электронов (сверху) позволяет получить функцию 

плотности взаимодействующих электронов, т.е. точную электронную плотность 
молекулы. б) «Фиктивная» система невзаимодействующих электронов Кона-
Шэма позволяет получить точную плотность взаимодействующей системы [1] 

XC–функционалы 

Стоит отметить, что DFT является точной теорией для нахождения 

свойств основного состояния системы, однако необходимы некоторые 

приближения, которые учитывают обменные и корреляционные эффекты. 

Такие приближения определяют точность, с которой рассчитываются 

структурные и энергетические свойства основного состояния.  

На сегодняшний день разработано большое количество XC-

функционалов. В качестве приближения энергию EXC можно заменить 

обменно-корреляционной энергией статического одноэлектронного газа – 

приближение локальной плотности (LDA): 

   
        ∫      ( ( )), 

где εXC – обменно-корреляционная энергия однородного электронного газа. 

Широкое распространение получило приближение, учитывающее 

пространственную неоднородность электронной плотности. Общий вид 

таких функционалов: 

   
         ∫    ( ( )   ( ))   

получил название обобщенного градиентного приближения (GGA). Разные 

GGA-функционалы различаются в выборе функции f(ρ, ∇ ρ). 
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Из-за того, что точное аналитическое выражение XC-функционала 

неизвестно, на практике используют разнообразные модельные 

функционалы, среди которых наиболее распроcтранены локальный 

функционал с параметризацией Воско-Вилк-Нусэ (VWN), градиентно-

скорректированные функционалы Беке-Ли-Янга-Парра BLYP,  Пердью-

Бурке-Эрзенхова (PBE) и гибридный вариант PBE0, а также гибридный 

функционал B3LYP. 

 

2.3  Молекулярная симметрия 

 Двухатомные и линейные многоатомные молекулы  

Для начала обратимся к атомным термам. Как известно, электроны в 

атоме характеризуются спиновым s и орбитальным l моментами. Обе эти 

величины являются векторными. Полные орбитальный L и спиновый S 

моменты атома получаются в результате векторного сложения величин s и 

l каждого электрона (связывание моментов). В рамках простой схемы 

связывания, называемой связью Рассел-Саундерса, суммирование 

отдельных спиновых моментов s1, s2, и т.д. дает полный спиновый момент 

S, аналогично и для l1, l2 и т.д. дает полный орбитальный момент L. 

Учитывая, что S и L сами являются моментами (векторами), то они, 

складываясь, образуют полный механический момент J. Совокупность 

состояний, описываемая одними и теми же значениями модулей орби-

тального L и спинового S моментов называется термом. Символ атомного 

терма записывается  в виде: 

 
2S+1

LJ, 

где J – модуль полного механического момента. Стационарное состояние 

атома характеризуют полным спином. Но также важна величина 2S + 1 (S = 

0, ½, 1), называемая мультиплетностью. Мультиплетность показывает 

кратность расщепления энергетического состояния по спину. В 

зависимости от значения мультиплетности выделяют синглетное (2S+1=1), 

дублетное (2S+1=2) и триплетное (2S+1=3) состояния.   Квантование 

моментов производится с помощью квантовых чисел. Для того чтобы 

избежать цифрового обозначения для орбитального квантового числа (0, 1, 

2, 3 и т.д.) используют латинские заглавные буквы S, P, D, F и т.д. по 

аналогии с s-, p-, d- и f-электронами. Энергетическое состояние 

одиночного атома определяется энергией его внешнего (оптического) 

электрона. Рассмотрим для примера основное состояние атома Ag: 
2
S1/2. В 

устной речи терм произносится как «дублет-S-одна-вторая». Атом серебра 

в основном состоянии имеет электронную конфигурацию [Kr]4d
10

5s
1
.  На 
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внешнем электронном уровне атома серебра находится один электрон, при 

этом его спин может иметь одно из двух направлений: ↑ или ↓, иными 

словами мультиплетность равна двум: 2S + 1 =  ⋅
 

 
      (дублет). 

Поскольку орбитальный момент s-орбитали равен нулю, то получаем обоз-

начение 
2
S. Значение механического момента находится как J = |L ± S|, J = 

|0 ± 
 

  
| = 

 

 
. 

В случае двухатомной или линейной многоатомной молекулы, 

электронное состояние еще может быть определено значением 

орбитального момента, направленного вдоль межъядерной оси. В данном 

случае обозначения сохраняются, однако вместо латинских букв 

используются греческие буквы. Так, используемые для атомов 

обозначения орбитальных моментов l и L заменяются на λ и Λ, которые 

относятся к отдельной орбитали и всей молекуле соответственно: орбитали 

с λ = 0, 1, 2, 3 заменяются буквами σ, π, δ, φ, тогда как состояния с Λ = 0, 1, 

2, 3 – буквами Σ, Π, Δ, Φ. В общем виде молекулярный терм записывается 

в виде: 

2S+1
Λ, 

хотя он может быть дополнен некоторой информацией. Это может быть 

подробная информация о свойствах симметрии волновой функции, которая 

может сохранять, полностью или частично, симметрию молекулы. Так, для 

молекул, симметричных относительно центра, волновая функция может 

либо сохранять, либо изменять знак при инверсии через центр симметрии. 

Такая волновая функция называется четной и нечетной соответственно и 

обозначается символами g или u по первым буквам немецких слов 

«gerade» и «ungerade» в виде подстрочных индексов Λ в конце терма. Для 

состояния Σ волновая функция может сохранять или изменять знак при 

отражении относительно плоскости симметрии, которая проходит через 

линию атомных центров: данное обстоятельство обозначается в качестве 

надстрочных индексов «+» или «–» после Λ. Рассмотрим в качестве 

примера основное состояние 
1
Σg

+
 двухатомной молекулы Ag2: в силу того, 

что все орбитали полностью заполнены, отсутствуют орбитальный и 

спиновый момент; волновая функция не меняет знак ни при инверсии 

через центр симметрии, ни при отражении. 

Молекулы, нелинейные по структуре 

У многоатомных нелинейных молекул полный орбитальный момент 

электронов L уже не может использоваться для описания электронного 

состояния, хотя спиновая мультиплетность еще сохраняет свое значение. 
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Поэтому электронное состояние нелинейных молекул, принадлежащих к 

определенному набору операций симметрии (т.е. таких операций, которые 

не изменяют молекулу), принято классифицировать по типу симметрии. 

Обсуждение операций симметрии является предметом отдельного 

изящного раздела математики – теории групп. Здесь же мы остановимся на 

самых главных результатах. Существуют четыре основные операции 

симметрии (рис. 11 а): идентичность (E), инверсия (i), поворот вокруг оси 

Cn (ось вращения n-го порядка) на заданный угол 2π/n, отражение от 

заданной плоскости σ. Порядок оси показывает сколько раз молекула 

совместится сама с собой при полном повороте вокруг оси. Например, 

молекула пероксида водорода имеет ось вращения второго порядка, что 

означает совмещение молекулы при повороте на угол 180°. Плоскость 

симметрии, перпендикулярная главной оси симметрии обозначается σh 

(horizontal), содержащая главную ось – σv (vertical). Например, молекула 

воды две плоскости симметрии σv. 
 Совокупность операций симметрии, выполнение которых оставляет 

неподвижной хотя бы одну точку молекулы образует точечную группу 

симметрии этой молекулы. В то время, как состояния молекул с линейной 

симметрией, характеризуются молекулярными термами, для нелинейных 

молекул именно точечная группа симметрии определяет каким образом 

будут обозначаться молекулярные орбитали. Точечные группы обозна-

чаются символами Шёнфлиса. На рисунке 11 (б) показаны точечные 

группы симметрии молекул, используемые нами в практической части 

методического пособия.  

Молекулы с осями симметрии n-го порядка характеризуются 

точечной группой Cn
1
 (см. рис. 11 б, сверху). Если в молекуле несколько 

осей, то выделяют главную ось вращения, обладающую наибольшим 

порядком. В молекулах, обладающих помимо оси C2, осями вращения Cn 

более высоких порядков (например, C6) может наблюдаться ситуация, 

когда С2⊥Cn. Если при этом молекула имеет плоскость симметрии σh, то 

она принадлежит к точечной группе Dnh  (см. рис. 11 б, посередине). Если 

же молекула не обладает свойством С2⊥Cn, но имеет n вертикальных 

плоскостей симметрии σv, то она относится к точечной группе C2v (см. рис. 

11 б, внизу).  

                                           
1
 В данном случае обозначение точечной группы совпадает с названием оси. 
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(а) 

 
(б) 

Рис. 11. а – базовые операции и элементы симметрии (С2) [2]; б – 
некоторые точечные группы симметрии [3] 

 

Символы симметрии A, B, E и T c дополнительными над- и подстрочными 

индексами отражают изменение волновой функции при различных 

операциях симметрии и именуются неприводимыми представлениями. Так, 

волновые функции типа A, A1, A' симметричны по отношению ко всем 

операциями симметрии молекулы и носят названия полносимметричных, в 

то время как A1 и A'' антисимметрична по отношению к плоскости 

симметрии. Различные B-типы говорят о антисимметричности относи-

тельно операций вращения, а типы E и T указывают на двух- и трехкратное 

вырождение соответственно. Примерами  символов термов основных сос-

тояний простых молекул являются H2CO (
1
A1), N2O (

2
A1) и C6H6 (

1
A1g). 
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ГЛАВА 3.  ПРОГРАММА КВАНТОВОХИМИЧЕСКИХ РАСЧЕТОВ 

AMSTERDAM DENSITY FUNCTIONAL (ADF) 

3.1  Знакомство с графическим интерфейсом 

Графический интерфейс в программе ADF представлен как более 

простая альтернатива командной строке, призванная повысить 

эффективность и наглядность работы с моделью. Работа с программой 

начинается с запуска модуля ADFInput, служащего для задания входных 

параметров и условий расчета. Окно программного модуля ADFInput (рис. 

12) состоит из следующих частей: 

● Главное меню (А) 

● Редактор молекул  

○ Область построения (Б) 

○ Строка состояния (В) 

○ Инструменты моделирования (Г) 

● Строка выбора текущей панели параметров (Д) 

● Инструмент поиска (Е) 

● Текущая панель параметров (Ж) 

 

 
Рис. 12. Окно программы ADFinput 

 

Удобным свойством программы ADF является наличие подсказок, 

привязанных к элементам управления, появляющихся при наведении на 

них курсора. Подсказки появляются в меню «Инструменты модели-
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рования», полях «Панелей параметров», а также в модулях «Levels» и 

«Spectra» при наведении на уровни и спектральные линии.  

Главное меню находится в левой верхней части окна и состоит из 8 

подменю. Особенно стоит выделить подменю «SCM», служащее для 

открытия и переключения между различными модулями графического 

интерфейса: 

«Preferences» Модуль позволяет настраивать и сохранять графические 

настройки интерфейса для всего пакета ADF. 

«New Input» Модуль входных параметров позволяет задавать геометрию 

молекулы, осуществлять преоптимизацию, формировать 

задачу и параметры расчета для всех программных модулей 

пакета ADF (ADF, DFTB, MOPAC и др., см. подробнее 

«Строка выбора текущей панели параметров»). 

«View» Модуль для просмотра геометрических и атомных свойств 

структуры, позволяющий также строить изоэнергетические 

поверхности и распределение электронной плотности 

вокруг молекулы. 

«Movie» Здесь можно визуально оценить динамику изменения 

расчетных параметров, а также получить промежуточные 

значения в цифрах. 

«Levels» Диаграмма энергетических уровней молекулы. В случае 

расчета кластеров слева приводится структура уровней 

одиночного атома, а справа – кластера. Получить инфор-

мацию (название, энергия, заполнение, составляющие фраг-

ментарные орбитали) об уровнях можно при наведении 

курсора на уровень. 

«Output» Подробный текстовый отчет о результатах вычислений. В 

подменю «Properties» приводится содержание отчета в виде 

ссылок. 

«Spectra» Модуль «Spectra» в графическом виде представляет 

плотность состояний энергии рассчитываемой системы или 

её спектр поглощения (в случае расчета спектров погло-

щения). При наведении курсора на спектральную полосу во 

всплывающей подсказке приводится название состояния в 

виде неприводимого представления, энергия в Хартри и 

заполнение состояния электронами. Кроме того, справа от 
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главного меню окна ADFspectra находятся вкладки 

неприводимых представлений с рядом соответствующих им 

состояний, присутствующих на спектре. Открытие этих сос-

тояний открывает модуль «View», позволяющий увидеть 

изоэнергетические поверхности для данных состояний.  

 

В подменю «File» содержатся команды, позволяющие создавать, 

открывать, сохранять проекты. Команда «Run» (Ctrl+R) запускает расчет 

молекулы, изображенной в «Редакторе молекул» с параметрами, 

заданными в правой части окна ADFInput. В подменю «Edit» при 

необходимости настраиваются симметрия молекулы, выравниваются или 

поворачиваются её элементы. Добавлять и удалять молекулярные связи 

можно с помощью команд «Bonds» → «Add Bond» (Ctrl+L) и «Remove 

Bonds». Для отображения в окне «Редактора молекул» информации об 

атомах, а также геометрических параметров молекулы удобно 

пользоваться вкладками «View» → «Atom info», «Geometric info». В случае 

затруднений с работой в программе или при необходимости дополни-

тельных сведений о ней, можно обратиться в подменю «Help».  

 

Окно «Редактор молекул» 

 

В окне «Редактор молекул» происходит задание структуры 

молекулы. В меню «Инструменты моделирования» осуществляется выбор 

типа атома из периодической системы («Element tool») или готовой 

молекулярной структуры («Structure tool»). В правой части панели 

«Инструменты моделирования» находится значок программы Symmol, 

выставляющей наиболее вероятный тип симметрии для изображенной 

молекулы. Программа UFF (Universal Force Field) позволяет выполнить 

геометрическую преоптимизацию молекулы. Инструментом по умолчанию 

является курсор («Pointer tool»), позволяющий выделять отдельные атомы 

и части структуры (при нажатой клавише Shift), вращать молекулу (при 

нажатой левой клавише мыши). После выбора требуемого элемента, 

нажатие левой клавиши мыши в области построения помещает в нее 

соответствующий атом. При этом инструмент остается активным, позволяя 

строить структуру из связанных атомов. Для завершения построения 

следует выйти из инструмента «Element tool» нажатием клавиши Esc. 

Последующее добавление связей, как было упомянуто выше, производится 

с помощью команды «Bonds» → «Add Bond» (Ctrl+L). Значение длины 

связи между двумя атомами можно видеть строке состояния Редактора при 
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выделении двух соответствующих атомов в области построения. Слайдер 

внизу экрана позволяет изменять расстояние между атомами в ручном 

режиме. Значения валентных углов определяются при последовательном 

выделении соответствующих вершин угла (атомов) и также показываются 

в строке состояния. Для изменения валентного угла также можно исполь-

зовать слайдер. Подписать названия атомов, длины связей и валентные 

углы на рисунке можно через подменю «View».  

 Задание параметров расчета системы происходит в правой части 

окна модуля ADFinput. Панель «Main» содержит настройки типа задачи, 

общего заряда, спиновой поляризации и ограничения по спину молекулы, 

выбор обменного потенциала, настройки учета релятивистских эффектов, 

выбор базисного набора, замороженного остова и точность численной 

интеграции при расчете. 

Вкладка «Model» содержит несколько панелей, в том числе, «Spin 

and Occupation», которая позволяет задавать заполнение электронных 

оболочек в модели. При заданной симметрии и параметре ограничения по 

спину программа предлагает свой вариант заполнения. В таблице по вер-

тикали приводятся номера состояний, а по горизонтали – неприводимые 

представления. В ячейках указано количество электронов, находящихся в 

данном энергетическом состоянии. 

Вкладка «Properties» содержит панели «Excitations», «Excited State 

Geometry» и «Franck-Condon Spectra», используемые при расчете спектров 

поглощения и люминесценции. 

Во вкладке «Details» находятся панели «Frequencies», «Select 

Excitations» и «Symmetry», позволяющие рассчитывать инфракрасный 

спектр, выбирать возбужденные состояния при расчете спектров погло-

щения и люминесценции и выбирать симметрию молекулы, соответ-

ственно. 

 

3.2  Наборы базисных функций 

Как уже было отмечено ранее в разд. 2, базисные наборы (basis sets) 

– это набор математических функций, которые позволяют описать МО в 

молекуле с некоторым приближением. В текущей версии ADF доступно 

разнообразное количество базисных наборов, которые покрывают все 

элементы периодической таблицы: от минимального одноэкспонен-

циального
2
 набора (SZ) до четырежды поляризованного четырехэкспо-

ненциального набора (QZ4P). Элементы данных наборов представляют 

                                           
2
 Базисный набор называют одноэкспоненциальным или единичным ζ-набором (SZ, где 

Z – экспоненциальный множитель). 
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собой функции слэтеровского типа (Slater type orbitals, STOs): 

 ( )          (   ), 

где Ylm – сферические функции (гармоники); n, l, m — главное квантовое 

число, угловой и магнитный момент, соответственно; r – удаление 

электрона от ядра. Экспоненциальный множитель ζ (орбитальная 

экспонента) определяет ширину функции, центром которой является ядро 

атома.  

Приближение замороженного остова 

 Важной особенностью ADF является возможность использования 

приближения замороженного остова (frozen core) для сокращения 

вычислительного времени путем уменьшения размера базисного набора. 

Это достигается за счет того, что внутренние (остовные) электроны могут 

быть «заморожены». Основанием для этого является то, что при обра-

зовании химической связи валентные орбитали атомов более подвержены 

воздействию других атомов, нежели остовные орбитали и приближение 

замороженного остова сокращает время без значительной потери в 

качестве. С применением замороженного остова мы получаем полную 

плотность заряда и потенциал в области валентных и внутренних орби-

талей, игнорируя только небольшие изменения во внутренних (deep-core) 

электронных оболочках атомов при образовании химической связи [2]. 

 Для большинства атомов периодической таблицы ADF предо-

ставляет несколько базисных наборов с разным уровнем приближения 

(размером) замороженного остова. Приведем пример соответствия такого 

обозначения и размера остова в программе ADFInput: 

● Small 

Rh.3d: все 28 электронов до 3d будут заморожены: [Ar]3d
10

. 

Валентные орбитали: 4s, 4p, 5s, 4d, 5p. 

Au.4d: все 46 электронов до 4d будут заморожены: [Kr]4d
10

.  

Валентные орбитали: 5s, 5p, 6s, 4f, 5d, 6p. 

● Large 

Rh.4p: все 36 электронов до 4p будут заморожены: [Kr]4d
10

4f 
14

. 

Валентные орбитали: 5s, 4d, 5p. 

Au.4f: все 60 электронов до 4f будут заморожены: [Kr]4d
10

4f
14

. 

Валентные орбитали: 5s, 5p, 6d, 6s, 6p. 
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ГЛАВА 4.  ПРАКТИЧЕСКАЯ ЧАСТЬ 

В данной главе собраны лабораторные работы, последовательное 

выполнение которых позволит приобрести навыки работы в программном 

комплексе ADF. 

 К каждой работе мы постарались привести минимальные теоре-

тические сведения, необходимые для ее выполнения. Рекомендуется их 

внимательное прочтение, а для более глубокого ознакомления читатель 

может обратиться к библиографическому списку, приведенному в конце 

каждой лабораторной работы. 

 

Требования к оформлению отчета 

 

 Выполнение лабораторной работы завершается подготовкой и 

защитой отчета. Отчет к каждой лабораторной работе должен содержать 

cледующие элементы: 

● информация об объекте исследования и параметрах расчета 

(обменно-корреляционный функционал, базисный набор и др.); 

● основная часть (см. «Содержание отчета»); 

● выводы. 

 

Лабораторная работа №1 

СТРУКТУРНЫЕ И ЭНЕРГЕТИЧЕСКИЕ СВОЙСТВА 

ДВУХАТОМНОЙ МОЛЕКУЛЫ БЛАГОРОДНЫХ МЕТАЛЛОВ 

 

ЦЕЛИ РАБОТЫ 

Знакомство с программным комплексом ADF. Исследование 

структурных и энергетических свойств основного состояния двухатомной 

молекулы благородных металлов (Cu, Ag, Au) 

 

ЗАДАЧИ, РЕШАЕМЫЕ В РАБОТЕ 

1. Поиск равновесной конфигурации двухатомной молекулы. 

2. Расчет электронной структуры и полной энергии связи. 

3. Построение кривой потенциальной энергии. 

 



29 

 

СВЕДЕНИЯ ИЗ ТЕОРИИ 

Кривая потенциальной энергии. Рассмотрим молекулу, состоящую из 

N атомов в виде модели жесткой геометрической фигуры с фикси-

рованными значениями длин связей, валентными и торсионными углами. 

Пространственную структуру такой молекулы можно определить с помо-

щью координат ее атомов в одной из систем координат (внешние коорди-

наты), например набором значений xi , yi , zi в декартовой системе. 

Потенциальная энергия системы U является функцией этих коор-

динат, каждой точке которой соответствует своя геометрическая конфи-

гурация; такую функцию называют кривой потенциальной энергии (рис. 

13). Зависимость эффективной энергии взаимодействия ядер в молекуле от 

межъядерного расстояния называют кривой потенциальной энергии 

(потенциальной поверхностью). Пусть, r0 – точка, соответствующая 

минимуму энергии и отвечающая устойчивым геометрическим конфигу-

рациям нашей структуры. На промежутке 0 > r0 энергетические кривые 

имеют аттрактивный характер, что соответствует энергии притяжения 

атомов, а на промежутке re < ∞ – репульсивный, соответствующий энергии 

отталкивания атомов.  

 

 
Рис. 13. Потенциальная кривая взаимодействия димера 

 

Экспериментальные данные. Для экспериментального определения 

структуры энергетических уровней полученных МК используются техники 

лазерной спектроскопии (например, резонансная двухфотонная иони-
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зация), фотоэлектронной спектроскопии. Равновесное межъядерное рас-

стояние является следствием колебательных процессов внутри МК, 

поэтому может быть определено тем же способом.  

 

Табл. 1. Экспериментальные значения межъядерного расстояния re  и энергии 

связи Eсв  димеров M2 (M = Cu, Ag, Au) 

Кластер re, а.е. Eсв, эВ Литература 

Cu2 4,19  2,016±0,08 [1] 

Ag2 4,79  1,656±0,03 [2, 3] 

Au2  4,67  2,296±0,02 [4, 5] 

 

ПОРЯДОК ВЫПОЛНЕНИЯ РАБОТЫ 

1.  Построение двухатомной молекулы 

Используя инструмент химического элемента «Element tool», 

разместите в рабочем поле Редактора атомы молекулы, которая 

соответствует вашему варианту. Для завершения процедуры 

нажмите клавишу Esc. Процедура создания молекулы посредством 

графического интерфейса ADF описана в разд. 3.1. 

2.  Геометрическая оптимизация молекулы 

1. Настройка параметров расчета осуществляется в правой части 

главного окна программы. Уточните следующие пункты: «Type: 

Geometry optimization, ZORA: Scalar. Выбор пунктов Basis set и 

XC Functional осуществляется в соответствии с номером варианта. 

2. Сохраните проект в рабочую директорию под отдельным именем 

(например, Ag2.adf). 

3. Запустите расчет (File → Run). 

4. Откройте окно ADFMovie (File → Movie) и добавьте график 

изменения энергии (Graph → Energy). Используя слайдер внизу 

окна, посмотрите как изменялась конфигурация системы и соот-

ветствующая энергия в зависимости от цикла оптимизации. 

3.  Интерпретация результатов расчета 

1. Анализ геометрической конфигурации и энергии связи. 

Перепишите полученное значение полной энергии связи ΔE (в 

Хартри). Для определения длины связи (в ангстремах) необходимо 

выделить два атома. Значения приводятся в строке состояния откры-

того окна ADFMovie.  
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2. Анализ электронной структуры 

● Откройте диаграмму энергетических уровней (SCM → Levels); 

● Зарисуйте симметрию трех пограничных уровней. Для отоб-

ражения неприводимых представлений, соответствующих 

уровням, активируйте данный пункт в настройках отображения 

(View → Labels → Show); 

● Для графического отображения граничных орбиталей HOMO и 

LUMO наведите курсор на соответствующий уровень, в 

контекстном меню выберите название уровня и откроется 

окно. 

3. Построение кривой потенциальной энергии  

1. Для выполнения данной задач необходимо сканировать потенци-

альную поверхность вдоль межатомного расстояния. Установите 

следующий пункт на панели параметров справа: Preset: Linear 

Transit. 

2. В Редакторе, выделив оба атома, выставите начальное значение 

длины связи между атомами равное 2 Å. 

3. Во вкладке Model → Geometry Constraints and Scan установите 

количество переходных точек равное 10 (Number of transit 

points: 10).  

4. Выделив оба атома в Редакторе, разверните появившуюся справа 

вкладку Distance. Укажите начальную и конечную длины связей в 

2 и 3 Å соответственно. 

5. Убедитесь, что во вкладке Main выбраны настройки по 

умолчанию (желтым цветом выделена только настройка Preset). 

6. Cохранив файл под другим именем (File → Save as…), запустите 

расчет. 

7. Для просмотра результата откройте модуль Movie (SCM → 

Movie) и добавьте график (Graph → Energy). На графике слева 

приведена шкала энергии, а внизу – шаги расчета. 

8. Сохраните полученный график (Graph → Save as…). 

 

СОДЕРЖАНИЕ ОТЧЕТА 

1. Расчетные и экспериментальные значения длины связи re и энергии 

связи Eсв: 

 

Табл. 2.  

 Расчет Эксперимент 

re, Å   

Eсв, эВ   
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2. Диаграмма энергетических уровней от LUMO+2 до HOMO–2 c ука-

занием неприводимых представлений. 

3. Изоповерхности граничных орбиталей HOMO и LUMO. 

4. Кривая потенциальной энергии. 

 

КОНТРОЛЬНЫЕ ВОПРОСЫ 

1. Что такое молекулярная орбиталь? Какую роль выполняют базисные 

наборы при проведении расчетов? 

2. Дайте определение энергии связи МК. Отличается ли она от энергии 

ионизации МК? 

3. В чем физический смысл кривой потенциальной энергии? Что такое 

равновесное межъядерное расстояние димера? 

4. Какие существуют экспериментальные методы определения структуры 

энергетических уровней МК?  

5. В чем особенности компьютерного моделирования относительно экспе-

риментальных методов анализа энергетических свойств МК? 

6. В чем смысл геометрической оптимизации? Какие параметры МК 

могут изменяться при геометрической оптимизации?  

7. Почему структура уровней энергии атомов и молекул (или МК) так 

сильно отличается?  

8. Для чего определять энергию связи МК? 

9. Какие факторы могут влиять на величину энергии связи МК? 
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Лабораторная работа №2 

ЭЛЕКТРОННЫЕ СПЕКТРЫ ПОГЛОЩЕНИЯ 

МОЛЕКУЛЯРНЫХ КЛАСТЕРОВ 

 

ЦЕЛЬ РАБОТЫ 

Расчет электронных спектров поглощения молекулярных кластеров (МК) в 

УФ и видимой областях спектра.  

 

ЗАДАЧИ, РЕШАЕМЫЕ В РАБОТЕ 

1. Поиск равновесной геометрической конфигурации основного состо-

яния в рамках формализма DFT. 

2. Расчет возбужденных состояний с помощью временно-зависимой DFT 

(TDDFT). 

 

СВЕДЕНИЯ ИЗ ТЕОРИИ 

Оптические свойства МК благородных металлов привлекают особое 

внимание. Классическая теория Ганса-Ми может качественно описать 

оптический отклик металлических частиц с диаметром порядка нескольких 

нанометров. Для объектов с меньшим размером, в том числе МК, кван-

тово-размерные эффекты становятся значительными. Классическая теория 

не позволяет описать подобное поведение, поэтому необходимо рассмат-

ривать свойства МК исходя из первых принципов (ab initio), в рам-

ках квантово-механического подхода. 

 Электронные спектры поглощения. В конечном счете, все опти-

ческие и спектроскопические свойства молекул, определяются рассто-

яниями между их энергетическими уровнями и вероятности перехода меж-

ду ними. Пользуясь теорией квантовых переходов, мы можем вычислить 

вероятность перехода с одного квантового уровня на другой под действием 

падающего света. 

Молекула, находящаяся в состоянии Ψн с энергией Eн, может 

поглотить фотон с энергией hυ, что сопровождается переходом молекулы в 

состояние с большей энергией Eк = Eн + hυ при выполнении ряда условий: 

1. Если существует такое состояние, при котором выполняется 

равенство (“условие Бора”): hυ  = Eк – Eн; 

2. Переходный момент     ⟨       ⟩, отражающий смещение заряда 

(изменение дипольного момента) во время перехода, не должен 

равняются нулю. Непосредственно дипольный момент равен 



34 

 

произведению среднего расстояния между положительными и отри-

цательными зарядами в молекуле на величину этих зарядов. 

Для количественной оценки интенсивности перехода часто исполь-

зуют понятие силы осциллятора f. Квантово-механический аналог силы 

осциллятора для перехода с энергией hυ из состояния Ψн в состояние Ψк 

записывается в следующем виде: 

     
   

  
(     )     

 , 

где me – масса электрона, ħ = h/2π – редуцированная постоянная Планка. 

Сила осциллятора есть величина безразмерная и ее значения для разных 

полос меняются от очень малых величин до порядка 0,1-1,0.  Силу 

осциллятора можно связать с экспериментально наблюдаемым молярным 

коэффициентом экстинкции ε согласно формуле Кравца: 

         ⋅     ∫    ̅, 

где ∫    ̅ – интеграл полосы поглощения. 

Правила отбора для оптических переходов. Однако экспериментально 

установлено, что не все переходы, удовлетворяющие условию Бора, могут 

наблюдаться. Ряд правил отбора указывает, при которых переходный 

момент равен нулю. Так, переходы разрешены только между состояниями 

одной мультиплетности: интеркомбинационные переходы (например, 

синглет–триплет) запрещены. Ряд дополнительных правил вытекает из 

рассмотрения симметрии волновых функций электронных состояний, 

между которыми происходит электрически-дипольный переход:  

1. Нечетные термы комбинируют только с четными и наоборот. Так, 

переходы g↔u разрешены, а переходы u↔u и g↔g будут 

запрещенными. 

2. Симметричные термы комбинируют с несимметричными: + ↔ –, но 

+ ↮ + и – ↮ –.  

Обычно запрещенные переходы слабы и основные особенности электро-

магнитного спектра системы описываются без учета таких переходов. Хотя 

приведенные правила отбора достаточно строгие, на практике нередки 

случаи, когда они в той или иной степени нарушаются. Например, 

подобные явления имеют место в молекулах, характеризуемых сильным 

спин-орбитальным взаимодействием. 

Обозначение возбужденных состояний. Для записи электронных 

переходов общепринято, что сначала указывается высшее состояние вне 

зависимости от того, сопровождается переход поглощением или испус-

канием фотона, а направление перехода указывается с помощью стрелки. 

Таким образом, запись X → Y обозначает испускание, а X ← Y – погло-

щение. Здесь X и Y некоторым образом обозначают состояния.  Приведем 

примеры: 
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● 
1
Σg ← 

2
Σu (в теории групп) 

● σ*
 
← σ (в рамках МО) 

● Однако, HOMO → LUMO+1 (относительно граничных 

орбиталей) 

Также можно уточнить те АО, которые оказывают значительный 

вклад в МО, участвующие в переходе: σ*(5s, 5p) ← σ(4s, 5s). При 

порядковом обозначении синглеты обозначаются как S0, S1, S2 и т.д. в 

порядке увеличения энергии, причем основное состояние принимается за 

S0. 

Ограниченный и неограниченный методы расчета. В системах с 

замкнутыми оболочками число электронов со спином α (↑), равно числу 

электронов со спином β (↓). На одной пространственной орбитали 

находятся два электрона. В этом заключается ограниченный по спину 

метод для систем с замкнутыми оболочками. Неограниченный по спину 

(спин-поляризованный) метод требуется для расчета систем с неспарен-

ными электронами, в том числе: 

● молекулы с нечетным количеством электронов (например, 

некоторые ионы) 

● возбужденные состояния 

● другие системы с необычной электронной конфигурацией 

(например, два неспаренных внешних электрона). 

В данном случае МО со спином α и спином β имеют разные 

пространственные части (рис. 14).  

В процессе расчета нам потребуется указывать значение 

поляризация спина: 

        , 

которая представляет собой разницу между числом электронов со спином 

вверх (α) и спином вниз (β). 

 
Рис. 14. Схема размещения электронов по уровням энергии МО в ограниченном 

(«restricted») и неограниченном («unrestricted») методах 
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Экспериментальные данные. Полезно знать, что спектры поглоще-

ния, получаемые при моделировании без учета окружения наиболее близки 

к экспериментальным спектрам МК в твердых инертных газах (рис. 15). 

 

Рис. 15. Оптические спектры Ag1,2,3 в матрицах различных инертных газов при 

12K [6] 

 

ПОРЯДОК ВЫПОЛНЕНИЯ РАБОТЫ 

1.  Геометрическая оптимизация 

Использую навыки, полученные из первой лабораторной работы, 

проведите геометрическую оптимизацию МК, соответствующему 

вашему варианту. В случае системы с открытой оболочкой (нечет-

ным количеством электронов), необходимо отметить пункт 

Unrestricted (неограниченный по спину метод расчета) и указать в 

поле Spin polarization самостоятельно установленное значение Ns. 

2.  Расчет спектра возбуждений 

1. Сохраните файл, например, Ag4_excitations.adf (File → Save as…).  

2. Данный тип расчета выполняется для фиксированной геометрии: 

Preset: Single Point. 

3. Справа перейдите во вкладку Properties → Excitations. Установите 
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следующие пункты: Type of excitations: Singlet only (Тип 

возбуждений: Только синглет-синглет), Number of excitations: 20 

(Количество возбуждений). 

4. Запустите расчет (File → Run), сохранив файл. 

3.  Анализ полученных результатов 

1. Откройте рассчитанный спектр (SCM →  Spectra → Excitation). 

2. Для получения детальной информации о переходе, наведите мышь 

на пик. В всплывающей подсказке приводятся такие характеристики, 

как энергия перехода, сила осциллятора, состав возбуждения в 

контексте орбитальных переходов. C полным списком рассмат-

риваемых возбуждений можно ознакомиться в выходном файле 

(SCM → Output) во вкладке Response Properties → All Singlet-

Singlet Excitation Energies. 

3. Перепишите значения энергии и силы осциллятора трех наиболее 

интенсивных переходов. 

 

СОДЕРЖАНИЕ ОТЧЕТА 

1. Расчитанный электронный спектр поглощения МК: зависимость силы 

осциллятора перехода от энергии фотона. 

2. Занести в таблицу вертикальные энергии возбуждения Te и силу 

осциллятора трех наиболее интенсивных переходов Sj ← S0. Указать 

МО, которые участвуют в переходах. В скобках уточнить положение 

МО по отношению к граничным орбиталям (например, HOMO–1, 

LUMO+2). 

 

Табл. 3. 

Sj Te, эВ  Te, нм f, отн.ед. МО → МО* 

     

 

3. На диаграмме энергетических уровней отметить стрелками переходы 

из таблицы.  

4. Для наиболее интенсивного перехода привести состав АО. 

 

КОНТРОЛЬНЫЕ ВОПРОСЫ 

1. Какие особенности оптических свойств наблюдаются у МК 

благородных металлов? 

2. Какие процессы внутри атома или МК отражаются на электронном 

спектре поглощения? 

3. Что нужно знать про МК для расчета его спектра поглощения 

методом DFT? 
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4. Какие физические величины определяют интенсивность и 

положение полос поглощения? Как они вычисляются? 

5. Может ли сила осциллятора быть равной нулю? 

6. Что такое запрещенные переходы? Разрешены или запрещены 

переходы: 

а. 
3
Σg

 
←

1
Σu, 

б. 
1
Πg

+
←

1
Σu

‒
, 

в. 
3
Σu

+
←

3
Πg

+
  

Почему?  

1. Как вы понимаете термин мультиплетность? В чем ее физический 

смысл? 

2. Для чего выделяют ограниченный и неограниченный методы 

расчета? 

3.  Существуют ли экспериментальные методы определения энергии 

связи и межъядерного расстояния для малых МК благородных 

металлов? Какие особенности имеет компьютерное моделирование 

по сравнению с экспериментальным исследованием свойств МК? 

4. Как синтезируют МК? Какие экспериментальные ограничения для 

получения МК существуют? 
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ПРИЛОЖЕНИЕ 1.  Некоторые фундаментальные физические 

постоянные
*
 

 

Величина Символ Значение Единица измерения 

скорость света в 

вакууме 

c 299 792 458 м с
-1

 

постоянная Планка h 6,626 0693(11) × 10
–34

 Дж с 

h/2π ħ 1,054 571 68(18) × 10
–34

 Дж с 

    

 

ПРИЛОЖЕНИЕ 2.  Связь между энергетическими единицами 

Энергия фотона: 

E = hν = hc / λ 

 

1 а.е.э. = 1 Хартри = 27,21138 эВ 

 

Пример: 400 нм = 25000 см
–1

 = 3.1 эВ = 0,114 Хартри
 
 

 

Примечание. 
*
 Mohr P. J., Taylor B. N. The 2002 CODATA Recommended 

Values of the Fundamental Physical Constants // Rev. Mod. Phys. – 2004. – Vol. 

76. – No. 4. 
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